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When a logger and a poet view the
same tree, it is no surprise that they
are unlikely to describe
the same way. Less expected is what
happened not too long ago when
two foresters were asked about the
worth of a street tree. The story goes
that a landowner had two large oaks

alue in

figure at $300 per tree. This was based
on the going price of firewood at $75
per cord. Seeking & second opinion,
the landowner found another forester
who used an appraisal formula and
arrived at 2 value of $10,000 per tree!
As is usually the case, the right tree
in the right place had more value as
a shade, or landscape, tree than for
any products it might yield. A third
side to this story is that the owner

himself treasured the tree not in terms
of dollars at all, but as part of a rich
store of pleasant memories

Itis easy to place a value on trees that are grown solely
for products. Foresters have done this for centuries. It is

of board feet of lumber or cords of pulpwood or =
and multiplying by the current market value. Simi workers need to use special care in working around trees. It
in an orchard are valued based on the bushels of fruit they can also help in building forestry programs that people
produce and the market price for that product will support.

The problems arise with non-commercial values. What is
the value of a shady place for an aftermoon barbecue? How place a dollas
‘much is the beauty of trees worth when you want to sell your  consider fair.
house, or when a drunken driver destroys your flowering

ow an attempt is made to
vay that all parties

dogwood? How do you place  value on a tree that was Theough the use of proper appraisal methods, it is often
planted by a departed parent, or that stood at the crossroads  surprising to discover how much trees are worth in the
when Civil War soldiers marched past? landscape. This, in turn, is a powerful argument on behalf of
protecting and providing care for street, park, and yard trees.
In the following pages, trees will be looked at in two It is akio an knportant step toward putting community forestry

ways. First is what trees mean to the heart. To foresters, an par with other public services.

Arhor Day Foundation
00 A ka City, NE 63410

Factors Considered in Determining a Tree’s Value

Size: Trunks are measured for diameter. The point
of measurement depends on the size of the tree.
Diameter is then converted to square inches of
trunk area.

/
o

1

Trees 4" Transplantable sizes Larger than
or less larger than 4" transplantable size

Trunk area = nR?
(at point of
i i I measurement)

Location: Location value is the average of the _<

ratings for these three factors.

Species: A rating is assigned to every species within a

geographical region. The rating is expressed as a percent

of “ideal” (5-100 percent) for that area and is based on
the tree’s suitability to climate and soils and generally
how well it grows there. Aesthetics and functional
attributes are also considered. State foresters can usually
supply this list.

f

Condition: A tree in good health is assigned a higher
condition rating than one plagued by disease, insects,
or physical damage. The range is:

0 percent dead or dying
5-49 percent poor

50-69 percent fair

70-89 percent good

90-100 percent excellent

Site: (10-100 percent) This is a highly subjective rating
of the general surroundings, with emphasis on quality
and design. A well-kept industrial park may be rated
90, whereas a run-down residential area could be 30.
But trees in areas of intensive tree care, such as along
a residential street, are usually rated higher than trees
in industrial zones or those that occur naturally in
woods along a roadside.

Contribution: (10-100 percent) The tree’s functional
attributes (shade, privacy, safety barrier) and

aesthetic attributes (flowers, shape, purposeful place
in landscape design, wildlife value, etc.) are in this
judgment. Historic values can be considered here, but
personal sentimental values are not taken into account
in any formula method.

Placement: (10-100 percent) The tree’s placement
affects its function and aesthetic value. A specimen
tree in the middle of the lawn would have more value
than a single, beautiful tree within a grove. A tree that
is large at maturity and has been planted under utility
wires or too close to the house will result in a low

placement value.
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Placing a Value on Trees
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1 is easy to think of reasons why trees in the community are important, but it is more difficult trying to assign a dollar

value. This is because trees appeal to emotions as well as ba

tandin
cater sensitivity.

unde
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When a logger and a poet view the
same tree, it is no surprise that they
are unlikely to describe its value in
the same way. Less expected is what
happened not too long ago when

two foresters were asked about the
worth of a street tree. The story goes
that a landowner had two large oaks
in the way of highway construction.
During negotiations about the value, a
forester was called in who placed the
figure at $300 per tree. This was based
on the going price of firewood at $75
per cord. Seeking a second opinion,
the landowner found another forester
who used an appraisal formula and
arrived at a value of $10,000 per tree!
As is usually the case, the right tree

in the right place had more value as

a shade, or landscape, tree than for
any products it might yield. A third
side to this story is that the owner
himself treasured the tree not in terms
of dollars at all, but as part of a rich

ng a practical, or functional, side. Through a better

of the many ways trees are valued, urban and communily forests can be managed more effectively

store of pleasant memories.

It is easy to place a value on trees that are grown solely
for products. Foresters have done this for centuries. It is
simply a matter of measuring wood volume (usually in terms
of board feet of lumber or cords of pulpwood or fuelwood),
and multiplying by the current market value. Similarly, trees
in an orchard are valued based on the bushels of fruit they
produce and the market price for that product

The problems arise with non-commercial values. What is
the value of a shady place for an afternoon barbecue? How
much is the beauty of trees worth when you want to sell your
house, or when a drunken driver destroys your flowering
dogwood? How do you place a value on a tree that was
planted by a departed parent, or that stood at the crossroads
when Civil War soldiers marched past?

In the following pages, trees will be looked at in two
wiys. First is what trees mean to the heart. To foresters,

developers, utility workers, and business professionals, this
is an aspect often ignored during the math and sdence of
college courses or in the hard-nosed world of work. Yet it
can explain why controversies arise over trees and why all
workers need to use special care in working around trees. It
«can also help in building forestry programs that people

will support.

The second section explains how an attempt is made to
place a dollar value on trees in a way that all parties
consider fair.

Through the use of proper appraisal methods, it is often
surprising to discover how much trees are worth in the
landscape. This, in turn, is a powerful argument on behalf of
protecting and providing care for street, park, and yard trees.
It is also an important step toward putting community forestry
on par with other public services.




How Much Is A Tree Worth
The Formula Method

It sometimes is necessary to place a specific dollar value available on the ISA's website at isa-arbor.com. Search the Store
on a landscape tree. Typically, this helps settle legal claims for  section for “appraisal.” The following is not intended as a do-it-
the damage or death of a tree, assists with insurance payments,  yourself guide, but it should serve to illustrate the components

TREE CITY USA

Appraisal Method #1: Replacement Cost

Trees up to 8 inches in diameter (4 inches in some localities and higher in

contributes to real estate assessments, and proves loss for
income tax purposes. Placing a dollar value on public trees can
also be used to help justify city expenditures for tree care.

There are several ways to establish value, and a key point
is to have it done by a professional. Only appraisals that reflect
experience and good judgment will be able to stand up in
court or before a claims examiner. To obtain the services of an
appraiser, contact the American Society of Consulting Arborists
referenced on page 8.

The most widely accepted formula mcthod is one dr:vdopcd
by the Council of Tree and Land. iscrs in its
Guide for Plant Appraisal, puhhshcd hy the International
Society of Arboriculture. This guide is regularly updated &

of landscape tree appraisal.

Factors Considered in Determining a Tree’s Value

Size: Trunks are measured for diameter. The point
of measurement depends on the size of the tree.
Diameter is then converted to square inches of
trunk area.

.J“'

Trees 4" Transplantable sizes Larger than

or less \ larger than 4" / fransplantable size

Trunk area = R’

m {at paint of
ailh measurement)

Location: Location value is the average of the
ratings for these three factors.

Species: A rating is assigned to every species within a
geographical region. The rating is expressed as a percent
of “ideal” (5-100 percent) for that area and is based on
the tree’s suitability to climate and soils and generally
how well it grows there. Aesthetics and functional

ib are also idered. State fc can usually
supply this list.

Condition: A tree in good health is assigned a higher
condition rating than one plagued by disease, insects,
or physical damage. The range is:

0 percent dead or dying
5-49 percent poor

50-69 percent fair

70-89 percent good

90-100 percent excellent

Site: (10-100 pcrm:nt) 11\15 is a highly subjective rating
of the g sur gs, with emphasis on quality
and clcsngn. A well-kept industrial park may be rated
90, whereas a run-down residential area could be 30.
But trees in areas of intensive tree care, such as along
a residential street, are usually rated higher than trees
in industrial zones or those that occur naturally in
woods along a roadside.

Contribution: (10-100 percent) The tree’s functional
attributes (shade, privacy, safety barrier) and

aesthetic attributes (flowers, shape, purposeful place
in landscape design, wildlife value, etc.) are in this
judgment. Historic values can be considered here, but
personal sentimental values are not taken into account
in any formula method.

Placement: (10-100 percent) The tree’s placement
affects its function and aesthetic value. A specimen
tree in the middle of the lawn would have more value
than a single, beautiful tree within a grove. A tree that
is large at maturity and has been planted under utility
wires or too close to the house will result in a low
placement value.

others) are usually considered transplantable. Value can then be determined by
obtaining price quotes from three local nurseries for the same or comparable
species of the same size. Transportation and planting costs at the same site
should be added.

This formula is then used:

Installed Species

Value = X Conditi X Site + Contribution + Placement

Cost * Rating 2

Note: Removal and cleanup cost may be added if appropriate.

Appraisal Method #2:
Trunk Formula Method

Trees too large for practical replacement by transplanting are appraised by
determining a basic value, then zd|us(mg by condition and location ratings.

11 d

A two-step process is fol in g the deter

Step 1. Basic Tree Cost = Replacement and installation cost of largest

normally available tree locally

Trunk area of +
a replacement
size tree Unit tree cost (i.c., cost per square inch of
(TA) trunk area of the replacement tree)
x
Mrunk (TA - TA)) The diffcn:n.cc between the
area of the trunk area of the appraised tree and a
appraised tree replacement tree
x
Step 2. Appraised o Trccc = Species 2 Condition . Location
Value T co = Rating Rating Rating

Government officials in Monroe County, New York, were able to place tree loss at a staggering $97.1 million
when a disastrous ice storm struck. Estimating tree values during street and park tree inventories can be
useful when frees are subsequently damaged or destroyed.

Note: Increases in trunk diameter on
large trees dramatically affect trunk
cross sectional area, and therefore basic
value. In fact, it becomes unrealistic

to say, for example, that a 31-inch tree
would be worth $1,300 more than a
30-inch tree when most people could
not even visually discern the difference.
To account for this, adjusted trunk area
values for trees more than 30 inches in
diameter are presented in table form

in the ninth edition of Guide for Plant
Appraisal or they can be calculated
using the formula: ATA = -.335d" +
69.3d - 1087.

The Bottom Line —
An Example

Using the above Trunk Formula
Method, a 15-inch di English
oak was valued by the Counul of Tree
& Landscape Appraisers at $4,400.
This was based on a $1,785 installed,
replacement cost for a 4-inch balled
and burlapped tree, and species
and condition ratings of 75 percent
and 80 percent, respectively. Site,

ibution, and pl ratings
for location were found to be 90, 80,
and 70 percent, respectively.
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What is i-Tree?

® A suite of tools to assess urban vegetation and their

ecosystem services and values

i-Iree i-Ilree  i-Iree  i-Iree

Eco Landscape Canopy Design

i-Treeis a
% Cooperative .
i-Tree Imitiative { @ DAVEY% @Arbor Day Foundation




Public-Private Partnership

® USDA Forest Service

® Davey Tree Expert Co. DAVEY%

@ The National
Arbor Day Foundation®

® National Arbor Day Foundation

® Society of Municipal Arborists

® International Society of Arboriculture

® Casey Trees nmiﬁ_

CaseyTrees’

NNNNNNNNNNNN



What is i-Tree?

“Putting US Forest Service science into the hands of users.”

Benefits-based approach

* Based on peer-reviewed research

A 15-year collaborative effort

e Technical Support

i-Tree Users
Warldwide: 320,000+

* www.itreetools.org e

College of Environmental Science and Forestry

@ arbo ES
r Day Foundation ISR ? ,vr‘F -
n mmg m (_ H 5‘ \ T[&Cb State }Jniversity of 'New York



Why i-Tree?

Opportunities for communities to...

* Plan and manage urban forest resources more

strategically to serve and protect citizens;

* Integrate urban forests in policies: sustainability,

climate, resiliency, air quality, public health,

stormwater, etc.;

e Support advocacy efforts with data;
* Improve preservation of trees and forests;

e Connect urban and rural forest importance.




Why i-Tree?

Opportunities for communities to...

I Project
Learning
Tree'

TEACHING WITH

i
Economic opportunities: I-Trge

. . WEY% Estimates of Your Tree Benefits
i C re a te g re e n I n d u St ry J O b S; hl'"" Sclutionss for o Gronrtogy Workd — More than an investment in beouty and shade, your trees work ngm/m;w, '

Prepared exclusively for: John Deere HQ — e =
Estimated Tree Cover for your property: 43.7%

Sustainable development; v

13,004,647 gallons @ $115,741

attract & retain new businesses and residents; ﬁ

Promote green tourism and investment;

Carbon Dioxide absorbed

each year by yourtrees:

Youth education & engagement; 28760 @ $101412

Carbon Dioxide already
stored in your trees:
78.163tons @ $2.755.674

* Develop new relationships & partnerships...



i-Tree’s Vision e

| Save on Your
| Energy Bills by
Planting Trees
To improve forest and human | i gl

health, and forest and city resiliency

through easy-to-use technology | |
that engages people globally in Help Us Breathe Easier
. Think about it...

enhancing forest management.




Estimating Tree Benefits

Air pollution removal

e Carbon storage and annual carbon
sequestration

* Avoided stormwater run-off (hydrology

effects)

Energy effects (home cooling & heating)

Structural assessment

S Value for ecosystem services

Public health impacts related to air
quality

S Urban Tree Canopy (UTC)
Wl Assessment for Massachusetts
10 Largest Communities

Urban Tf‘ée Canopy Cover Assessment
for the City of Chicopee

from a Climate Change Perspective




Tree species, size and |leaf area area are key to
calculating ecosystem services (benefits).

LEAF AREA =l

LURBAN FOREST BENEFITS =3

TREE SI1ZE/AGE i



Quantify Tree Benefits with  Research Science

Carbon dioxide storage and sequestration
Air pollution removal
Storm water reduction

$2.94 in benefits
for every $1.00 spent

Beneftt Summary for

Pittsburgh’s Street Trees

Benefits Total ($)
Energy 1,205,133
CQ? | 535,424 Mnnafg’cmcnt
Air Quality 5252,035 e S ,
Stormwater 354,601

Aesthetic/Other  =572.882

-3 Total Benefits 2.400.975

4

- ™ The only infrastructure
£ 720 45300000 Cooling Beneft . .
, \7, that increases in value

Thisk about it...

i S— over time.




Research Science and Data Development

Commercial Practitioners

Citizen Scientists



What are your urban forestry challenges
and opportunities?

Executive Summary

Ioneer Vafley Plonnng Commvssion

PioneerValley
Climate Action and

Clean Energy Plan

oyt
D R e e ]
s et le KaBe e By men Fareng el Py e

March /2014




The Foundation: Local Data

*Local Sample or Inventory

*Local information:

e Weather

* Pollution

* Environmental
Variables

*Hourly simulations




Tree Benefit: Improve Air Quality

* Absorb pollutants through e, TR
leaf surfaces B e e o \

" O; (ozone)

" NO, (nitrogen dioxide)

" SO, (sulfur dioxide)

Gaseous Pollutants
Absorbed Through Leal
Stomates and Lenticels

\ | Advare o Surfaces
* Intercept dust and/or ~{
particulate matter (PM10 e
and PM2.5)

Trees Save Energy for Cooling and Heating,
Thereby Reducing Pollutant Emissions
from Power Plants

* A reduction in energy -
production needs reduces j
creation of many air |
pollutants g

(] Re | e a S e Oxyge n Image courtesy of the Center for Urban Forest Research



Improving Air Quality

Oxygen and Volatile Organic Compounds
e 15” Oak at 20 years (| bS) . Released Through the Leaves

* NO,=0.98
SO, =2.72
PM;,=0.52
Ozone =0.84
VOCs =0.21

Gaseous Pollutants
Absorbed Through Leaf
Stomates and Lenticels

Small Particles
\ Adhere to Surfaces
N/\_/

USDA Forest Service, Springfield, MA i-Tree, 2019 Image courtesy of the Center for Urban Forest Research



Tree Benefit: Reduce Carbon Dioxide CO,

* Trees are largely made of carbon |
so they take carbon out of the air - A .
and turn it into tissue (bark, RLE o
leaves, wood, etc.)

* Tree can help reduce home energy
needs, which also reduces
additional carbon emissions
released from power plants in the

CO: is Released Activities

first place (Secondary benefit) g “
and Mulch \M,

Image courtesy of the Center for Urban Forest Research



Reducing Atmospheric Carbon Dioxide

10” diameter deciduous shade trees

Trees Save Energy for Cooling,
Thereby Reducing CO, Emissions
from Power Pian

¢ 100 trees remove five tons
of CO,/year

¢ 100 trees remove about
1000 lbs of pollutants per
year, including:
400 lbs of ozone

300 Ibs of particulates

USDA Forest Service, Brattleboro, VT, i-Tree, 2020

Image courtesy of the Center for Urban Forest Research



Tree Benefit: Hydrology Effects

Intercepts and holds rain on S—

leaves, branches, and other anopy itercption Tl
and Evaporation o ‘

surfaces N

Transpiration

Reduces stormwater runoff

Increases water storage in N
SO|| Surface

Pervious
Surface

Increase infiltration and -,
helps reCharge aqUife rs - ‘ Evapotranspiration
(underground water) | S

N\

Roots Take Up Soil
Moisture, Increasing

b X Runoff Storage
Infiltration Potential

Reduces erosion

Image courtesy of the Center for Urban Forest Research



Trees & Energy — Summer Effects

Northeast U.S. Average

«Save up to 30% of annual
air conditioning costs

«Save 10-25% of winter
heating costs

Shade east & west windows,

prevent blocking the view.

but prune lower branches to

Plant on the west & northwest to
provide mid-to-late afternoon shade in
most locations

: y

Plant shade trees over
patios, driveways, and
, air conditioning units

Image courtesy of Arbor Day Foundation
https://www.arborday.org/trees



https://www.arborday.org/trees/

Trees & Energy — Winter Effects

Northeast U.S. Average

«Save 10-25% of winter
heating costs

Tree windbreak can reduce a 35-mph open wind velocity
to about 10-mph near here

...and about
15mph here

\.

Image courtesy of Arbor Day Foundation
https://www.arborday.org/trees,



https://www.arborday.org/trees/

Tree Benefit: Energy Effects Summary

* Trees shade buildings and
built surfaces (summer)

e Act as a wind break
reducing heat loss when
cold (winter)

® Trees cool the air — (climate effect)

® Reduce energy demand at power generation source
(Secondary benefit)

Image courtesy of the Center for Urban Forest Research



Conserving Energy

Wind Speed Reduction
Reduces Air Infiltration

Northeast U.S. Average

«Save up to 30% of
annual air conditioning
costs

«Save 10-25% of winter
heating costs

USDA Forest Service, i-Tree, 2021

Image courtesy of the Center for Urban Forest Research



i-Tree

Tools for Assessing and Managing Community Trees & Forests www.itreetools.org

What is i-Tree? 1 T

i-Tree is a suite of free software tools for estimating and quantifying the benefits 1- r ee
trees provide to our communities. These benefits are typically expressed in dollars and amounts of
carbon dioxide and air pollution removal (ozone, sulfur dioxide, etc.), as well as stormwater reduction.
Raising awareness of these tree benefits increases the desire to nurture and protect trees.

Who is using i-Tree?
« Teachers, students, & homeowners learning about trees beyond their aesthetic benefits.
« Companies investing in natural capital as part of their sustainability efforts.
« Governments & organizations improving their community forest management.
« Consultants & Innovators developing urban forest management plans, climate action plans, and
interactive tree maps for their clients and the public.

How does i-Tree work?

Structure Function Value
Assess the number of Statistically estimate functions (e.g. gas Apply monetary values to these
trees, species, condition + exchange) and covert to services such services based on economic
weather & pollution data. as CO, uptake & rainfall interception. models & published literature.

pe—

Where does i-Tree come from?
i-Tree was established in 2006 and is now
used around the world. Based on peer-
reviewed, publicly accessible USDA Forest
Service research, the mission of i-Tree is to
disseminate this science to large numbers of
diverse users in an easy to use format.

i-Tree is a non-profit, cooperative effort

among these partners:

B paveEr®E Ouvormsn g’ ISR A5

Colloe o ot mamtns e ooy

How do | get i-Tree?

Learn about these free tools at www.itreetools.org. Links to them as well as references,
project examples, and video learning segments are available. Want to ask a question?
User support is provided: info@itreetools.org.

Tree Benefits! Growing 20 years in Ohio, USA, one red maple can:
« Remove 3,000 pounds of carbon dioxide from the atmosphere.

% -« Filter 15 pounds of pollution from the air we breathe.

© o Save 500 kWh of electricity and 20 million BTU of fuel used for cooling & heating.

« Avoid 5,000 pounds of CO, and 30 pounds of pollution in powerplant emissions.

« Intercept 25,000 gallons of rainfall and avoid 4,500 gallons of runoff.




I-Tree

Tools for Assessing and Managing Community Trees & Forests www.itreetools.org

MyTree "
Explore the benefits of I.Tree
trees near you. "
« Got 2 minutes?
« Go to mytree.itreetools.org on

your phone, tablet or laptop!

i-Tree Canopy i-Tree Landscape
Estimate tree & ground cover for a large project. Learn about your entire community.
« A free web tool: canopy.itreetools.org « A free web tool: landscape.itreetools.org
« Simple, random sampling of a project area to « US watersheds, cities, census areas & more
estimate tree and ground cover. « Get estimates of tree benefits in

« You also get total estimates of tree benefits: - 10 minutes:
CO; & air pollution removal - CO2 mitigation
- Stormwater reduction - air pollution removal

- stormwater reduction

4 easy steps & 30 minutes: .
- health benefits

1. Draw project boundaries on a Google map. : o "
2. Enter ground cover types to survey. « Generate planting prioritization scenarios.

3. Select the ground cover you see on the (S pepe———————

map at random, auto-selected locations. € = C | @ httpsy/landscape.itrestools.org
4. Click the Report button for results!

ﬂ i-Tree Landscape ,,,,.,  Home Project

Cover Class
Impervious Other
12 [Tree/shrub
[1mpervious Buildings
:Tree/Shrub

Grass/Herbaceous

¥

Tree/Shrub | B Caa 3
Impervious Road Canopy 02 equivaren:
Tree/Shrub -] Sequestration
Impervious Other o < acre s % S Siyr T tyr 3
Lakefront 6789 2364 94866 2495
Downtown 96442 2416 401,305 10,560.7
i-Tree Eco The Flats 28717 47.16 1,347,713 35466.1

For community forestry managers.
« A free tool for Windows PCs.
« Supports street tree inventory imports.
« Includes mobile phone/tablet field data collection tools for complete or sample inventories.
« The best i-Tree estimates for tree benefits with comprehensive reports.
« Download Eco at www.itreetools.org

I-Tree

Tools for Assessing and Managing Community Trees & Forests

OurTrees
Provides data on a community and it’s tree
cover.

* Quick tree canopy and related information
for any city or town within the continental
United States using your a browser or
Android / Apple device

« With inputs of a city or town it will estimate
the amount of carbon dioxide and air
pollution a city’s trees remove, as well as
stormwater impacts.

It's quick and easy! Just a couple of simple
steps to get results.

1. Enter your city or town’s name and state
2. Get a complete report immediately on your
smartphone or computer

OurTrees L3
™

Community

Lormiont Locefont Locaimd oot et

ek e e b ot i e

otk S o 14 et

Boston, MA

—~ Population

ok Pl e

Under § 32420

oo 8. w710

P am

e TEs

Moty Peecant an.1%

= Income Overview

Medan Incame. 50684

Per Capma tecome 31856

Percent Impoverished 15.9%
= Homes

Totad Housing Unis 272481
Modan Yaar Buit o
Medan Value $395.200

4 Household Types

+ Home Tenure

based on USDA
for guisan
5 1o wrn more

+Read iha fne print,

www.itreetools.org

i-Tree Design

Estimate tree & ground
cover for a large project.

i-Tree

» Afree web tool:
design.itreetools.org

« Just input location, species, tree size, and
condition

+ Calculates greenhouse gas mitigation, air
quality improvements, and stormwater
interception.

4 simple steps in minutes:

1. 'Draw’ a building footprint on a Google Map

2. Virtually"plant" or place an existing or proposed
tree location

3. Select tree species and size

4. Repeat or click Report button for your results!

i-Tree Design vio
Get started with these easy sleps:
1. Draw Structures
2. Place Trees
Descrbe your tree:




www.itreetools.org Resources

e

gt
i-Tree delivers current, peer-reviewed tree benefits estimation science from

the USDA Forest Service toall types of users with free tools and support.

The trees around you:
remove hazardous pollutants from
the air you breathe,
absorb carbon dioxide from the air
to store as wood,

and control storm water by

Trees provide more than
just beauty and shade.

They work hard for all of
us, every day!

Click here to learn more.

intercepting and absorbing rainfall.

Tools for assessing individual trees

MyTree
Are you new to i-Tree? Start with our EASIEST tool! MyTree helps
you quickly assess individual trees with a minimum of fuss.

via your web browser or Android | Apple devices

i-Tree Design
A full-featured web tool with expanded building interactions and
forecasting for estimating the benefits of individual trees.

s S p
via your w eb browser

i-Tree Eco
Eco is our flagship tool that accommodates tree inventory IMPORT
or field data evaluation to derive individual tree benefit estimates.

requires installation on a Windows PC

Tree canopy area assessment tools

More tools...

OurTrees

Beta release: Quick tree canopy and related information for your
community within the continental US!

via your web browser or Android | Apple devices

i-Tree Landscape
US tree canopy and Census maps/data at your fingertips! Identify
priority planting & protection areas for climate & social issues.

via your web browser

i-Tree Canopy

From your chair, easily estimate land cover and tree canopy plus
benefits using random point sampling on aerial imagery.

via /\'U!If web .]M"UH‘.V:’]'
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i-Tree quick summary data for any community

OurTrees Home Project Menu~

A tree canopy assessment tool.

i-Iree.

OurTrees

i-Iree,

Where is your community?

[ ®

For the CONTINENTAL U S enter a city and state above and/or use the map below.
Q df l Reve !

M#Assachusetts Bay

Hingham “

Get Results! =

VIS C O Satellite

Some locations may fail to calculate if no matching location is found in our
database — if your calculation fails please edit your location by spelling out

any abbreviations or try using a nearby city.




i-Tree quick summary data Boston, MA

OurTrees Benefits OurTrees
. i-ITree. iTree.
1.. ree Trees in Boston, MA Community
n Serving Size: Location! Location! Location! Context is important
16.96% tree canopy on 5,240 acres when it comes to the trees all around us. Here are
Ou rTreeS 60.45% impervious surfaces over 18,677 acres some fast facts from the U.S. census:
Total benefits for this year: $7,532,749
Boston, MA
Annual values: .
— Population
Carbon Dioxide Uptake $896,712
Total Population 617,594
Carbon Sequestered 5,256 tn
Under 5 32,420
: 1
CO; Equivalent 19,273 tn Under 18 103,710
Storm Water Mitigation $923,081 Over 64 62,237
Runoff Avoided 103 MG/yr Median Age 31 years
. Minority Percent 46.1%
Rainfall Intercepted 307 MGlyr
Air Pollution Removal $5,712,957 — Income Overview
Carbon Monoxide 4,632 |hlyr Median Income $50,684
Per Capita | 31,856
Ozone 178,000 Jp/yr er Capita Income 3
Percent Impoverished 15.9%
Nitrogen Dioxide 61,033 Jhlyr
Sulfur Dioxide 17,627 Iblyr. — Homes
PM, 5 12,898 Ihlyr Total Housing Units 272,481
Median Year Built 0
Median Value $395,200
Carbon Dioxide Uptake $34,197,062
Carbon Storage 200,453 tn + Household Types
€O, Equivalent' 734,994 tn + Home Tenure
1
Benefits are based on USDA Forest Service Benefits are based on USDA Forest Service
research and are meant for guidance only. Visit research and are meant for guidance only. Visit
www.itreetools.org to learn more. www.itreetools.org to learn more.
=+ Read the fine print *Read the fine print.




i-Tree quick summary data for any community

1 ]
I-Tr eem % OurTrees Home Project> Menu~

i-Iree. A tree canopy assessment tool.

OurTrees , _
Where is your community?

VS
a lexington, ma Search (\ ?/,I

For the CONTINENTAL U.S., enter a city and state above and/or use the map below.

- % )
“NéWton l 0S

ﬁacnei

Get Results! =

& Streets

= : ~\
O Satellite

Some locations may fail to calculate if no matching location is found in our database — if your

calculation fails please edit your location by spelling out any abbreviations or try using a nearby city.




i-Tree quick summary data Lexington, MA

OurTrees e OurTrees L

i-lree. i-lree.

i_TI. ee Benefits Community
o Trees in Lexington, MA

Location! Location! Location! Context is
important when it comes to the trees all

Serving Size:

OurTrees 50.79% tree canopy on 5,342 acres around us. Here are some fast facts from

26.13% impervious surfaces over 2,748 the U.S. census:
acres
Total benefits for this year:  $3,101,662 Lexington, MA
:
— Population
Carbon Dioxide Uptake $873,331
Carbon Sequestered 51191tn Total Population Sl
CO; Equivalent’ 18,770 tn Under 5 1,438
Storm Water Mitigation $943,651 et Ly
Over 64 5,851
Runoff Avoided 106 MG/yr
Median Age 46 years
Rainfall Intercepted 454 MGlyr
Minority Percent 24.5%
Air Pollution Removal $1,284,680
Carbon Monoxide 3,343 Iblyr + Income Overview
Ozone 244,649 |blyr
1oryr — Homes
Nitrogen Dioxide 86,230 |bfyr
Total Housing Units 12,019
Sulfur Dioxide 17,792 |blyr
Median Year Built 1958
PM; 5 13,199 Ibfyr
Median Value $682,600
Values are totals to d
Carbon Dioxide Uptake $39,239,488 + Household Types
Carbon St 230,010}
O = + Home Tenure
CO; Equivalent’ 843,3711n

1
Benefits are based on USDA Forest

L]
Benefits are based on USDA Forest

Service research and are meant for Service research and are meant for
guidance only. Visit www.itreetools.org to guidance only. Visit www.itreetools.org to
learn more. learn more.

<+ Read the fine print. <+ Read the fine print.
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i-Iree.



i-Tree on the go...

@® treetools.org

s ... ' for individual or multiple trees!

i-Troe

MyTree Benefits ﬂ

Serving size: 1 ElIm, Chinese (Ulmus
parvifolia)

Carbon Dioxide(CO3) $108.34

CO; absorbed each year 2778.08lbs

Storm Water $28.63

Rainfall intercepted each year 4618 gal.

Air Pollution removed each year $1.82

MyTree Benefits

Serving size: 1 Eim, Chinese (Uimus.
parvifolia)

Ozone 12.00 oz

Carbon Dioxide(CO2)

Nitrogen dioxide 0.48 oz
Sulfur dioxide 0.16 07

Large particulate matter”™ 15.20 oz

Energy Usage each year $10.10

Electricity savings(A/C) 96.54 kWh

Fuel savings{NG,0i1) -13.99 therms

Avoided Emissions

Carbon dioxide 1223.201bs

Nitrogen dioxide 0.00 oz




I-Tree Design

i-Iree



I-Tree Design

’GDDI][E Custom Search H Search ‘

€ - A
Tools for ng and Managing u : = -
% 1- I ree Community Forests Get the Tools. T~ ’l_.':z;er'rnirr'ne ‘ Password ‘ Login }

Forgot Username or Password? Pigister

applications utities Support
i\ /B ) & /. /. /B ) & /)

I-Tree Benefit Calculator 1500 N Mantua St, Kent, OH 44240, USA Home

Get started with three easy steps:

1. Draw your house or building and locate your
tree:

Use the drawing toal t]lto outline your house or
huilding. Be sure to outline "conditioned" living area
only; garages and other unheated or cooled spaces
should not be included. Use the tree tool ?’ to locate
vour tree; place the marker as close to the base (or
center) ofthe tree as possihle. Planting on the East

and West sides of your house will save you money on
your summer cooling hills.

@] N @@ @ S

You may find it easier to outline the building and place
your tree by zooming in.

1]
[+ 8 < Jiefl > |

n |
—
|

2. Indicate when your house or building was

built: 1950-1980 v

3. Enter your tree's information:
’Oak, Naorthern pin ¥
Ifyou're looking for a Willow Qak it's listed as "Qak,
Willow”". If your tree isn't listed, use the general "Other"
listings.

Enter the diameter of the tree; how wide is the
trunk of your tree at about 4.5 feet above the ground?

Im‘éggr'y @2010 GeoEye, State fOSIP - Terms of Use
Lat:41.1713839 Long:-31.3589928 Bearing:104.3, Distance:6.1m (20.0ft) \ertices-12; Acea:981.2 m? (10346.5 ft)

describes your tree.

[ Calculate Benefits ]




I-Tree Design

i- Tree Design
Tree Benefit Report

Glenwood and Lincoln Elementary
Schools

Springfield, MA

ReGreenSpringfield

In partnership with

SPRINGELET 1y

Prepared August 2014

David Bloniarz, US Forest Service

Daniel Strom, University of Massachusetts
Benjamin George, Regreen Springfield, Inc.
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I-Tree Canopy

@ i-Tree Canopy

6

o

C @ localhost:8

i-Tree Canopy ¢4

+Iree

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey. The easiest option is to select a pre-existing boundary, but you can draw your ow
areas right on the map, or load in one or more shapefiles.

1 nose? P 2 b d intn mages mmaale oo ”
Just curious? Dive right into survey mode with an

existing project.

Launch Our Example Project

Ready to survey your ow

functions to define mop arecs.

Administative

W O US Census Block Groups .
R O US Census Places /
R O County Subdivisions /
R O US Counties

R O US 115" Congressional Districts

@ (O US States > &

Load ESRI Shapefile

Draw or Add Areas

Map data ®2019 Imagery 2019 NASA, TerraMetrics | Terms of Use




I-Tree Canopy

Quick, statistical
estimate of Canopy
cover and associated
benefits.

* Create custom cover
classes

 Random point locations

* Does not automatically
assign cover class at point

]

B 2855 Wosdcret Dive Faslimn OH % @ - Tree Canogy: Defise Prepect st « |

coy itreatool g dali re gy

I-Tree Canopy.

Define Project Area

$)oa -

Ll

BSave SLoad T hop

Cover Classes
Cover Class
ree
2 NonTree

+ /7 0¥

Select Froject Locations Selected Locations

T Ckescrobe ® Lneid Stakes of Amancs
7 Crangs ®onca
T Cuveols ® Cranze
T Palin Swwch o Xl oRusl
Passe
Pl
Palk =
P.tnam
Z Santa Resa
I Sarascta
o Samwrok
T 5t Jorns
™ S Luce it

Abbreviabon
T Tree, non-sheub
NT All other surfaces

Page 1 ofl

Benefit Options
Yihich regemsen) Toos Canupry?
BT Tres
INT Nen Trze

= Urdan

Tree, non-shrub 17
A other surtaces NT

1 Tree
!‘W\-T'erera

Tree

id Cover Class

PM2.5
S02

PM10*

Carbon Monoxide removed annually
Nitrogen Dioxide removed annually
Ozone removed annually
Particulate Matter less than 2.5 microns removed annually
Sulfur Dioxide removed annually

Particulate Matter greater than 2.5 microns and less than 10 microns
removed annually

CO2seq Carbon Dioxide sequestered annually in trees

Carbon Dioxide stored in trees (Note: this benefit is not an annual

CO2stor rate)

$174.40 4752  656.72 b
$156.26 +42.58 1511.651b
$9.24984 1252035 948 T
$17.94275 +4888.94 848.771Ib
$6.22 +169 133891b
$6.763.14 1184278 2487

$81,60357 +2223490 231464T

$1,321,118.93 £359,971.39 3747284 T 1




I-Tree Canopy

@ i-Tree Canopy X A
- C @® localhost:8001/map#
€ Canopy

Tiexs A tree canopy assessmant tool

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey. The easiest option is to select a pre-existing boundary, but you can draw your own areas right on the map, or load in one or more shapefiles.

" -
AL
~ ;"":'. %
CAMBRIDGE 2% 2

GHLANDS b
bl /12 ANEIGHBORHO

Just curious? Dive night into survey moda with an

Roady to survey your own arsa? Use these
functions to map your project boundanes.

US Boundaries

Administative

R O US Census Block Graups 7
R @ US Census Places /
= O County Subdivisions >
IS Counties

S 116" Congressional Districts
| O us States /
Watersheds

R O Hydrologic Unit Code 12
Community Grounds

= O Cemeteries

R O Colleges & Universitios
R O Companies

R O Golf Courses

R O Hospitals

UK Boundaries

l W Load file Boundary

[ # orew B

Work with map boundaries

% SOUTHN
$5C MMEDEORD




I-Tree Canopy

@1 i-Tree Canopy x + - z 2
€« C @ localhostB001/survey * @ @ 00
ﬂ i'Tree Ca nopy wy Home Projecty Menu~ i-Tree Feedback ¥
iree

Conduct your survey: With each point you add, the map will shift to a new, random location where you assess the land cover at the yellow crosshairs in the center of the map. The more
points you survey, the lower your standard error, and the more precise your sampling will be. More points provide a better estimation of Land Cover across your study area.

ID Cover Class Latitude Longitude

Impervious Other 41.74094 -72.65320

Impervious Road 41.74315 -72.66277
Tree/Shrub 41.76941 -72.68937
Grass/Herbaceous 41.78738 -72.69409
Tree/Shrub 41.73479 -72.67216
Impervious Other 41.78946 -72.66989
Tree/Shrub 41.79791 -72.71115
Tree/Shrub 41.74369 -72.66156
Grass/Herbaceous 41.80402 -72.71483
10 Grass/Herbaceous 41.79908 -72.65136

+ @2 M M Page10ofS50 W w

Murphyirg




I-Tree Canopy

i-Tree Canopy v7.1

Cover Assessment and Tree Benefits Report
Estimated using random sampling statistics on 10/15/2021

Land Cover

% Covered

Cover Class

15miz T
10miz Tl

5mi2

Omi2

W

T

i-Tree

magery 52021 TerraMatrics

Grass/Herbaceous
Impervious Buildings
Impervious Other
Impervious Road
Soil/Bare Ground
Tree/Shrub

Water




I-Tree Canopy

i-Tree Canopy v7.1

Cover Assessment and Tree Benefits Report
Estimated using random sampling statistics on 10/15/2021

Land Cover

60%

40%

% Covered

20%

10
0%""H 1B 10 R S T

Cover Class

15miz T
10miz Tl

5mi2

Omi2

W

W

i-Tree

magery 52021 TerraMatrics

Grass/Herbaceous
Impervious Buildings
Impervious Other
Impervious Road
Soil/Bare Ground
Tree/Shrub

Water

Land Cover
60%
he)
Q
| -
0 40%
o
(o]
L 20%
0,
0 1B 10 IR S T
Cover Class

15mi2

10mi2

5mi?

Omi?2

o~

W

Grass/Herbaceous
Impervious Buildings
Impervious Other
Impervious Road
Soil/Bare Ground
Tree/Shrub

Water




I-Tree Canopy

& e Cavapy x o+

€ 3 C @ localhostdin repocs

! i-Tl'ee Canopy Ay Homo Propctv Repoty Memuv  LTee

i-Tree Canopy v6.1

Cover Assessment and Tree Benefits Report
Estimated aving rordom wampling atistics on 11/74/79

Land Cover

W Grasz/Herbacecus
B Tree'Shnub
B Irpenicus Buldings
B Impandcus Road
W Impanvicus Otter
W mater
W SolRare Grourd
Cover Class

Cower Class Description

GrasMerbeocus

Tree/Shnd

Inpenious Suldings

x

- 0 X

" BRE 00
Feedback » 3
i-Tree

H Grass/Hertaosous

T TewSad

B Inpenvows Euldngs

R Irgennous Road

0 Invpevon Coer

W Wate

S SoliBareGrousd

Total

Tree Benefit Estimates: Carbon (Engli
Description Carbon (T)
Sequesteres 2neusly n tiees 412059
Stored in vees (Note nol an ennusl rate) 10371151 27,784
Comwecy & 0 UGS 200007 o0 2 Wmovl 300 Seoe SW0or S oW S0 00 300A8T e & 1N ond desied ot
Tree Benefit Estimates: Air Pollution (Ei

Abbr.  Description

© Carbon Mongeds remaned ennually

N2 Nivogen Dioode rersoved arnualy

a Oneme remoed seovally

P25 Partioulate Matter bess than 25 macrons semoved ansually

502 Sulbur Dicted remoned antually

10 Partioulate Nater greanar than 2.5 riceons and less Man 10 microns removed enmually

Total

A Palme [rarnes o0 Ded on ede rakws 0 200on e § ST CO2 100 B SR NODENS @ NN QRSN | AQS TN § 4l
ol o M Con) vt st o $eiind s O Sewpind and Consed s

. |

" 2264147 62030 *

3 W/ 197 4N 035

b7 uE£159 256 £ 029

4 3504125 155023

105 202182 361033

21 4204050 07606

13 250+ 00N 04T+ 013
Rlsbr, Description Value (USD) +SE Amaunt (T) =SE
© Carton Mongeds remaved annualy 204242 $15330 9 #0125
NO2 Nivogen Dvonde reroved arnualy $1.95581 21880 815 061
a3 Ozone renoved senualy §77.039.58 578238 5757 1432
PM2s Partioulate Matter Jess than 25 microns semowved ansually $15619615 NTIT6S 236 021
02 Subbur Dicvade remaoved anrually $12028 =903 154 2012
PM10* Particulate Matter groatar than 2.5 microns and 'ess $han 10 microne remoned snnually §26.90082 201908 A1 +0.£0
Total 526417487 11982823 a141  s6n

A Dotition Extenetes et Seowd 0 st oo o Bueeye @ ST CO 2 1N @ SIQ22T WEQ 5308 @ S0N0N 107 30060 @ 5102 A2 | 0025 T R00 § 354001 SO0 108 KRN M1 S § 52272 Caveny 3 i LSS Dhendind vy of
Ol Sud b ST Y DOV 3 EENEc o of conpled and cixaied polex.

Tree Benefit Estimates: Hydrological (English units)
Valea (USD) 15

238

£ Evipotation NA NA 21678

T Tampraton NA NJA 3nma 22178

PeT Potentd Evapotanspivaticn NA NA 136084 10282
AARORE EZINT T BOTrS o0 e rolett 2 Mpab e MRD LA FAT L ATE| TIRE| FE XSS FET 2008, Mpamopant telet § Dooed 08 Sman s of Avmdng Avaall or FE A A0Mpab i Conany & 0 ST Saanond o of mewnal ond ey
cmounts oo boved on savdend mron of sewplng and aixaied poies

Adiat s Tree Cegy

TN CONONE 30 FTENER OF TV AN warh Gt 2003 by Qe | Nowak Me%en, T VAI0n 300 59 L Grmeiels JGDA Fomm Sancal The Gumers virion of TG sragemm mdi 30vioptd I 3300mes 13 1T By Donid Blmgracen, Vi inciey a0d o3
Macz ha Cowy e Soet Compeny)

Lttors of +-Tres Carepy

The mcounacy of the wruhois deoends son e sy of the eaet 2 Covety dansly eich port e & corwdt dath ) P ruevber of DOs POwite U precsor of the e wete w8 mowine i e sinded e of P asieun ol decuiie V100 e pooty
W0 S e TEN0 e el 34 150 NP 10 Ny el Sy C T w2 306

B paver®  Oueonemsen gt

G of Sy S ot cxcrpdanee of e LA




I-Tree Canopy

@ e Cavapy X

€ 3 C O localhostdin) repos
! i'Tree CanOpV Ay Homo Project Roganty  Meru v
I-Tree Canopy v6.1

Cover Assessment and Tree Benefits Report
Estimatend axing rovdom wampling datistics ow 71/704/79

Land Cover

Graez/Herbacecus
Tree/'Shrud
Inmpenicus Budings
Irpandous Road
Imparicus Onrer
Mater

Sol/Bare Grourd

S0 Covered

N LR WS

Cover Class

Land Cover

3

ered (mi?)
lg.:

Area C
3

2

1

s

B 1R

Cover Chass

" ER2 00

.

Feedbace *

Grass/Fertoooous
Tree/Sheuh
Inperviows Beddings
Impervious Read
Impervious Other
Water

SalRare Geaund




I-Tree Canopy

- Grags/Herbaoeous "3 2264147 4064034
1 Trea/S2nud 31 122197 4N £035
B Imgenvous Euidngs i) 14E£159 2564029
R Ingennous Road 43 02125 155£ 023
0 Imgennous Ceher 105 202182 361033
w Water 21 420050 0762016
5 SolBare Groued 13 2602 0N1 0472013
Total 520 1000 £ 0.00 180 £ 0.00

Tree Benefit Estimates: Carbon (English units)

Description Carbon (T) +SE €O, Equiv. (T) <S8 Value (USD) +SE
Sequesterad snsusly n tees 412959 23039 11218 2113653 STOLISBAT 25267546
Stored in vees (Nole nol an ennual rate] 10871151 27.78433 33027702 £2354254  SVTEATITIY 2132285850

Convecy & 0 VS 200007 400t 8 Weoedl’ 20 S 20or S O 5236 01 3008077 vt 7 120w ool cesfed paimt

Tree Benefit Estimates: Air Pollution (English units)

Akbr. Description Value (USD) +SE Amount (T) =SE
«© Carton Mongodz remened ennually $204242 15330 39 025
NO2 Nrogen Dyoods rertoved arnualy $1.95531 &N &15 061
a3 Ozone remoed annually §77.039.58 5782385 5157 432
PM2s Partioulate Natter bess than 2.5 macrons semoved ansually $156.19615 ST 68 246 021
502 Sulbur Dicrode remaned anrually §12028 2903 154 012
P10 Partioulate Natter greanar than 2.5 mriceons and leds ™an 10 microns remoned enmually $25.90052 201909 799 040
Total §264,17487 +10.828.23 #141 HNn

A Palceve [rarecnes o 5esed 0 e ralw 0 BLeour § ST CO2 I PR MOUIAIE OXNN URMIFSIIN MRS TAI UMM 2 10FIRE IMNIT IS § TR Qeveey 3 e VS fondodevn
el o M S ) s om Il ey O avpied o Coma e pome




i-Tree Canopy

$264,17487 11982823 8141

A Potition Extencties oot Sevd 00 e ralves 0 Buoeye @ ST CO 21N @ 22T WEQ S @ 0N 1 07 30000 5102 A3 | 25 1AM § Sidiie s w'momnmrswcmw Coveny 3 V0 Dentind evmr of
ol ool ba TR Y DO 3 LRl o of sonpind and cxalied polex:

Tree Benefit Estimates: Hydrological (English units)
Albr.  Beneit Vake (USD) 15 Amount (Mgal) :5E

£ Evipoaticn N/A N/A AR 1878

T Tarspraten NA N4 3ma 22178

BT Potentl Bapovanspiaticn NiA NA 136084 10282

AARORS! ESINENT S ORS00 3R rolkets A MG AT RO LI FO0G TS| TIRE| FE RS PET 2008, Marmopast 1ol § Dosed 08 Sman st of Avmdvd Al on R MG S0Mgak T Comany & 0 LD Saanond’ anors of el ondf banart
Cmownts ovr boved o Farden e of ;ewping and aoxa e poles:

Adiat s Tree Cwegy

T CONONE 30 TR0 OoF T PPN wIre vt 3003 by Ovie | Nowak Me%en T Wamon 303 57 ) Grmeviels JG0A Fortm Sancal The Gumers vinson of TG rognian adl S0voeed g 3200med 13 - T By Donid Bliagracen, Ve linciey g S0
Macz e Cewy e Doet Carpeny)

Lmitors of - Tres Cancpy

Tt vy of the e desendt mon e ity of the sst 30 covecty Cansly i poirt mha B coredt dant ) e i of oS POwite U precaor of U e v ele o0 mowiie i e sinde e o P st o decuiie V100 e pocty
29 TREEE e TG e Al 30 120 NgP 10 Nan Iy I Sariany ©f the mTr 30

B paver® Omeowemse g SR P

e of SR o otes cocrpioree of e LA




I-Tree Eco

i-Iree.



Project Configuration Data

[Project: Adrian] [Serie;drian_ZOIZ] [Year: 2012] -Eee?co v6.0.3

(= | E et

Project Land Ground Dieback
Definition = Use Cover

Define Data Fields

N

View Reports Forecast Support
Load from File 2= @ ‘—J/
B3 via Gooagle Maps
(&3 o Project & c Editing
2 User Defined Strata Area Mode: Off
Define Plot Export

Help

Project Configuration > Project
Definition > Project Settings

The Project Settings tab seen in the
action panel to the right is where you
identify many of your most important
project settings.

Steps:

1. Enter a name for your project in
the box provided. Your project
name gives your i-Tree Eco
project a unique identity. This is
also the name that will be used
when referring to your study
area in your model results
(available on the Reports tab of
the ribbon).

2. Enter a series name for your
project in the box provided.
Again, your series name helps to
give your project a unique
identity. It can be used to
identify the exact nature of the
project - for example,
“ParkTrees” or “City" - to
distinguish it from other Eco
projects done at the same time in
the same place, if necessary.
This series name can be used in
the future to reference the data
for this project.

3. Enter a series year in the box
provided. It is recommended that
you enter the year of your data
collection for this variable.

-~

m

Project Configuration > Project Definition

Enter project overview information and click OK to save it or Cancel to quit this
process.
Project Settings ‘ Location | Data Collection Options

What name would you like to give your new project?
Project Name: |Adrian

What name would you like to give your series?
Series Name: Adrian_2012

Please specify the series year for your project:
Series Year: 2012

Please specify the following inventory information:

Inventory Type: Plot Sample

iI-Tree Eco v6

Flagship tool with best
estimates for Composition and
Benefits.

» User interface & Help text
* Reporting

* Tree inventory import

* Mobile data collector

Help text

Plot Sampling & Complete
Inventories



i-Tree Eco v6

[Project: Adrian] [Series: Adrian_2012] [Year: 2012] - i-Tree Eco v6.0.3 E@]ﬂ
Project Configura Data View Reports Forecast Support
—= 0p0 17 = . .
(28 & [{@sMaA DS [ | Flagship tool with best
Paper ' Submit  Retrieve Plots Trees Shrubs Check | CSV KML | Benefit Annual Editing g p
Form ' to Mobile from Mobile Data Prices Costs | Mode: Off . f e, o
Data Collection ‘ Inventory Data ‘ Export ‘ Inventory Value’ | e St I l I I ate S O r CO I I l pOS It I O n
Help q d B f M
~ | Data > Inventory Data > Trees a n ene ItS.
Data > Inventory Data > Trees Tl
The Trees table seen in the action Plot ID Survey Date Status Distance (ft) Direction Species 3
panel to the right displays the tree
data that you collected in the field 1 1 4/24/2012 Planted 0.00 140 | Red maple (Acer rubrum)
(s.e e Notes below). This is where you = 2 1 4/18/2012 Ingrowth 21.20 208 | Boxelder (Acer negundo)
will enter your tree data manually or .
edit your previously added or 2 2 4/18/2012 Ingrowth 31.00 206 | Boxelder (Acer negundo) ° U ser | nte rfa ce & H e I p Text
imparied date. Wiile working in this 3 1 4/25/2012 Planted 30.70 178 | Freeman maple (Acer x freemanii)
table, you may use the tools in the
Actions group to help manually enter 4 1 4/23/2012 Ingrowth 21.30 32 | Tree of heaven (Ailanthus altissima, .
new data or edit data that has ] e 2 4/23/2012 Plarted 240 224 | Norway maple (Acer platancides) ° Re p ortin g
already been added.
| D 4 3 4/23/2012 Planted 37.20 298 Northem white cedar (Thuja occide
itepé ItokMan:a“g Add}{ Edit Data: y 7 1 4/19/2012 Ingrowth 35.00 14 | Siberian elm (Uimus pumila) . .

. ick in the box where you wou T t m t
like to enter data and begin 7 2 4/19/2012 Planted 30.00 80 | Honeylocust (Gleditsia triacanthos) ¢ re e I nve n O ry I p O r
typing. 7 3 4/19/2012 Ingrowth 26.80 130 | Black walnut (Juglans nigra)

2. Usethe Tab key on your - .
keyboard or the left and right 7 4 4/159/2012 Ingrowth 22.30 258 | Blue spruce (Picea pungens) ° M O b I I e d ata COI Ie Cto r
arrows to move from side to side 8 1 4/24/2012 Ingrowth 28.20 20 | Siberian elm (Uimus pumila)
within a record. -
3. Usethe up and down arrows on 8 2 4/24/2012 Ingrowth 25.80 30 | Black walnut (Juglans nigra)
the keyboard to move from top to 8 3 4/24/2012 Ingrowth 28.10 43 | Norway maple (Acer platanoides) PY H e I t ext
bottom between records. ) - p
4. For boxes that contain drop- 1" 1 4/27/2012 Ingrowth 11.80 338 | Shellbark hickory (Carya laciniosa)
down lists, you can choose your 1 2 4/27/2012 Ingrowth 15.20 338 | Black chemy (Prunus serotina)
thaia from the I.'St or beg|rj typing 1 3 4/27/2012 Ingrowth 3460 352 | American elm (Ulmus americana)
and the matching label will be
automatically filled in. 1" 4 4/27/2012 Ingrowth 10.00 0 | American elm (Ulmus americana)
5. Thetable can be sorted by 1 5 4/27/2012 Ingrowth 17.70 10| Black cheny (Prunus serotina)
column in ascending or .
descending order. To sort, click 1 6 4/27/2012 Ingrowth 3520 20 | Siver maple (Acer saccharinum) P I ot S am p I N g & CO m p I ete
on the desired column header. 1 7 4/27/2012 Ingrowth 15.10 20 | Buttemut (Juglans cinerea)
6. For boxes where dates are .
entered, a calendar pop-up will " 8 4/27/2012 Ingrowth 28.70 30 | American elm (Ulmus americana) I n Ve n to r I e S .
appear if you click on the < >
i i icht-hand
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* Basic mapping

Shagbark hickory
_ Eastern redbud

- Northern hackberry
T Alaskacedar

- Flowering dogwood

Plot Sampling & Complete
Inventories.




i-Tree Eco - Data Import Wizard " @

Select an inventory column below and then define how to import it into Eco. Repeat for EACH

at that time. Pl
your data, the
may not reflect
made. To ensur
data to the se
again.

column BEFORE clicking Next

DEH Trunks

Cond | Canity

‘ WeakFork

ij |

i-Tree £co - Data Import Wizard

Total records procesesd. 520
Total records skipped: 7
Total records to mpert: 483

Processed Dala to Import

Review the results of your processed data.

Species

Acer ubrum

Please review your data after chcking Finish. Addtional modfications may be required to meet your project specrfic requIrements.

Cick Finigh Lo complets the import process or cick Back Lo revies your sstings end reprocess your dats.

[ <Beck || Ensh | [ Conce |

I Prunus seroting

Prunus sarotina

i-Tree Eco v6

Flagship tool with best

estimates for Composition
and Benefits.

e User interface & Help text
* Reporting

* Tree inventory import

* Mobile data collector

* Basic mapping

Plot Sampling & Complete
Inventories.
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Plot1-GPS Loc...

Help

Land Use Plot Info

Type in coordinates, use device GPS, or tap a location

Data > Data (

Status 1-Ingre

Mobile Land Uses Dead Tree? on the map below.
i-Tree Eco of || I P'rection () Ground Covers Crown Condition 85% - 90% )
recording the Lt : Latitude 41.908656011
the field. Onq Distance (ft) Reference Objects Height (ft)
record your L [
R ongitude -84.0385827151
datta)'[w::lletcm Street Tree Trees Crown Top Height (ff) [
mobilie data
:nmaaﬂ;c:'g:;b Comment | rom wmp = se builgng <o Shrubs Crown Base Height (ft) cessing Device GPS (allow location access on device):
our collecte] ] — Slﬂl m— ——
me e vt Mark Plot as Completed Crown NS Width (ft) dress
tab of ribbo!
functionali Crown EW Width (ft) Timestamp
have to dow . access |,
web-based i Crown Percent Missing | 93 V) Tree Accuracy (ft)
form. n.
Crown Light Exposure 4 (v :
The purpose proi Tap map for coordinates (requires data connection):
function seer Percent Impervious 0 (v
the right is tc ——
configuration | Percent Shrub 63 (V) ne

will be able tf
mobile device
mobile data
below).

*IMPORTANT
Before you ca
mobile data co!
device, you must SEGS
configuration here (see ™
If you do not submit your project
configuration, you will not be able to
access the mobile data collector from
your mobile device.

[C]|3260 11/1/2010




Reports > Map > Composition and Structure of Individual Plots

Note. this tool only aisplays valic LoTtude and Longtuge cooraingres.

+ Search by Id
* e T
3 \l Dz
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l
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™ so
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) ¥ o e (5 ! .
= O L 0‘3 ~ - Species Name: Sour orange
= @«
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= g Wil
2 g | %of Totak 0.1 a
O @ /& ‘
3 .
® . 3 & |
) 7
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e

© OpenStreetMap contributors.

i-Tree Eco v6

Flagship tool with best
estimates for Composition
and Benefits.

e User interface & Help text
* Reporting
* Tree inventory import

e Mobile data collector

* Basic mapping

Plot Sampling & Complete
Inventories



I-Tree Landscape




Boundaries

i'Tre e Lan d sCape : i Main CanoPy  Fores! Administaive

(@) us Census Block Groups
Climate 2020 (RCP 4.5)

Gateway to tree benefits — available to anyone and it | O usCensusPlaces
everyone in the US. Camale 2030 (RCP 45) (X US County Subdivisions

Climate 2040 (RCP 4.5) ( uscounties

() us 115" Congressional Districts
Climate 2050 (RCP 4.5)

* Uses existing boundaries. [ @ us states

Climate 2060 (RCP 4.5)

* Canopy, Land, and Impervious Cover across i 2070 PP 41 Forest (US Forest Service)
the US. » (@ National Forests
e UTC-sendus you rs! ) G e ( Ranger Districts
* High Resolution Urban Tree Canopy Assessments Climate 2090 (ACP 4.5)
e 250+ map |ayers o Climate 2100 (RCP 4.5)
b 7 base map.s - Olmsted*alls Climate 2020 (RGP 8.5)
* 10 boundaries, plus 26 federal types ,
o 7 canopy and land Climate 2030 (RCP 8.5) Nl US Federal Lands
* 6 forest risk, plus 47 pests Climate 2040 (RCP 85) Native American Reservation
e 17 health ris|.< Climate 2050 (RCP 8.5) Bureau of Land Management
* 144 future climate Find Locations e 2060 (1CP 85)
* Upto 18 new ones coming with v5.0 Bureau of Reciamation
Climate 2070 (RGP 8.5)
* 1,000's of data attributes and tree benefits i 2080 e 85 pepaimentofbetense
organized for easy exploration. ST
Climate 2090 (R ) -
. . [ . The following descriplions ol ™ (FR84)
o P I a ntl ng p rl O rlt I Zat I On tOOI more details and a thorough Forest Service
Climate 2100 (RCP 8.5) -

'
Let S Get Star Note: Predicted temperature and precipitation based Fish and Wildlife Service
on CCSM4.0 from Nafional Center for Atmospheric
Each i-Tree Landscape ploq Research.

National Park Service

shown below the map. (To

Map defails are localed in the references.




@ Explore LocationData -~ X | + x |
&« > C @ OO8 ntps:landscape itreetools.org/maps/locations/ ezl N €@ »

i-Tree La n d Sca pe ﬂi i-Tree Landscape ... Home Projects Menu~  iTree Feedback +

————— e P — ——

Start on Main, then explore the map layer tabs.

=11

Gateway to tree benefits — available to Euchd _ ool el
anyone and everyone in the US. e Main | oland Risk Rk  Cimate
o ) Base Maps -
Geve “dl {  Boundaras +
LTeveland A
A good place to get people started R ;
I n I_Tre e . &y Vilsge Lakow(%}i . Choose a boundary area to analyze:
_r@—- ROy BIE Shaker H . Peppy
Eﬂ»‘f«]l‘de & ah i Bl | s US Census Block Group :l @
. B3 & rafienra | - o %ﬂ \_ = Use these tools to work with the map:
A q u IC k to u r Ofu e i = = 422 + Navigata i wentty
orth Olmsted ﬁ 2 Mpple Heghts @ |
o Parma adfagg ! % o
e |ocation Data o Brook Park >d_{,lj\:;}’ sefofs g Fof] | @ seea O Box Select

. . ? — = Geo-Swap
* Making a selection
d lassificati o——
[ J
La n Cove r C aSSI |Cat|0 ns Find Locations Explore Location Data See Tree Benefits Prioritize Tg
Map details are located in the references.
* and tree canopy :
Land Cover @ Unit Display
o ThematIC ma pplng m HiRes = 2011 | 2001 Metric | English Table Chart m
Canopy Legend
Data Tools Area Land Cover HiRes Land Cover 2011 Census [ Minimum: 0.8 “uture Climate

Maximum: 271.8

Canopy & Impervious Forest Details mn| [ | O -

Lighter colors reprasant lower values, whia
darker colors represant higher values

Area warrwpy nipor vivus Plantable Space
f i
@ % PE % W% W%

Remove Dalaset ¢ Type ¢ Name ¢ ID ¢ Swap Highlight acre $ % ¢ acre ¢ % ¢ acre ¢ % ¢ acre ¢ % ¢

v Selection Total: O 52,829.7 100.00 95476 19.18 25629.6 51.49 14,5239 29.18




i-Tree Landscape

Gateway to tree benefits — available to
anyone and everyone in the US.

A good place to get people started
in i-Tree.

A quick tour of...

 Tree Benefits

e Carbon (CO?), air pollution,
hydrology

* Planting Prioritization
* Weighted prioritizations
* Custom scenarios

* Maintenance vs new planting
* (vs highest priority; i.e. both)

&) Prioritize Tree Planting X } +

& - C ® | ®© & httpsi//landscape.itreetools.orgimaps/prioritize/

Find Locations Explore Lecation Data See |
Land Cover @
I
€ Back HiRes | 2011 = 2001

How To Prioritize Tree Planting

To map optimal areas to plant trees, create a "Prority Planting Index"

scenario from user-specified, weighted criteria (under Custom Scenarios)
or use one of the Commen Scenarics (abeve). Scenarios are based upon

the Land Cover dataset selected (above) - HiRes, 2011, 2001.

The three Common Scenarios are:

« Population: (default) an index weighted towards areas of relatively

high population density, low tree cover per capita, and high
available planting spaca.

« Minorities: an index weighted towards areas of relatively high
minonty population density, low tree cover per capita, and high
available planting space.

« Poverty: an index weighted towards areas of relatively high
proportion of population below the poverty ine, low tree cover per
capita, and high available planting spaca

To create a Custom Scenario:
1. Select from one or more criteria (the blue boxes under Custom

Scenarios) by using the + Add Criteria button and their drop-down.

» For each criteria, set an Importance (from 0 to 100). The
sum cf the all weights must equal 100.
» Optional: to distribute weights equally among the selected
criteria, click the Equalize button.
2. Click Update Map Display to see the results on map (above) and
legend (below).
3. Each Custom Scenario can be stored by clicking Store Scenario.
These saved scenarios can be included in your report when you
Generate Results

Current Prioritization Scenario Legend

The index is from 0 to 100, where 0 is a low priority and 100 is a high

B % IN € @ »

TTTTTTNUMT-WOOURO U TOW OENTSITy UBNRIOpRU 210U

*

Wooded to high density developed 2100
Wooded to low density developed 2100

Priority Planting Index Extras

Tree Stocking Level

Tree Cover per Capita

Population Below Poverty Line
Minority Population Density

Tree Canopy Benefits

Carbon Storage

Carbon Sequestration

CO: Equivalent Storage

CO: Equivalent Sequestration
CO Removal

NO:z Removal

Q3 Removal

PM;.5 Removal

High = Low

{ )
o

Trow Coverpor Capita 1 I

Imporiance (welght)

= Equalize

© Update Map Display

+ Add Crileria Slore Scenario

Stored Planting Prioritization Scenarios

Remember to update the map's display after restoring a custom

priority. prioritization scenario.
How? Remove Title Criteria Restore
__Each criteria is standardzed on a scale of 0 to 1, with 1 reoresenting the P v c r——

Population Density (3




i-Tree Landscape

Gateway to tree benefits — available to
anyone and everyone in the US.

A good place to get people started
in i-Tree.

A quick tour of...
* Reporting

* Title and description
 Example tables
 Example thematic map

Example prioritization map

landscape.itreetools.org

¥ Report - i-Tree Landsca; X 4+
- >

C @@ ®O& nhtps//landscape itreetools.org/reports

Tree Benefits
barbon and CO2 (Hig

Selection Total: 1887085

EPrioritization

h Resolution UTC)

Carbon COz Equivalent CO; Equivaient

Carbon Storage Sequestration Storage Sequestration
Short Ton

¢ $yr & tUyr ¢ $ ¢ ShortTong $yr o vyr s

11,0646 60,259 3533 1,887.066 40,570.0 60,259 1.29552

iPopuIatIon (High Resolution UTC

der Prer 0

Edgewater
ark
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Use of this lool Indicales acceptance of the EULA
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I-Tree Planting




ﬂ i-Tree Planting ..,  Home Project~  Menu~  i-Tree

i-Tree.

Welcome to the i-Tree Planting Calculator! ..,

The i-Tree Planting Calculator is designed to help you estimate the long-term environmental benefits from a tree

planting project. The focus is on greenhouse gases, but many co-benefits are included.

This is a newly updated version of i-Tree Planting. Please clear your web browser's cache for this site before using.

Users enter the following information:

The following information is calculated (in units and associated dollar values) for the project life time:

Tree species

Size of trees at planting

Information on the distance and direction to the nearest building (optional)
Information about the tree’s growing conditions

Estimated mortality (optional)

The number of trees with each configuration

Project lifetime (number of years)

Specific greenhouse gas values (optional)

Greenhouse Gas (GHG) sequestered and avoided (owing to reductions in energy use)
Energy conserved

Air pollutants captured and avoided

Stormwater filtered

Tree total biomass

QN A DEPAK
A m

#o e Uy

";ﬂ'“ L Tec,

california |
Eiurbanforests .

Urban Ecos

Feedback v

i-Iree

Planting

O Get Started

Use of this tool indicates
acceptance of the EULA.



A collaborative initiative with

‘}':JE 6TRY &FIRE PRO
0}

= ORNIA DEPART

NT,
ritngf'

% |—Tree PIant'ng o Home Project » Menu ~ i-Tree Feedback v

i-Iree
Location Parameters Trees Report
Location

Select a location at, or near, the project site.

State/Province

<>

Massachusetts

County/Division

<>

Hampden

City
Springfield

<>

WARNING: If you already have tree groups entered, they will be retained, but changing the location will change the Report results.

Each of the three location selections needs to be completed in order:

e State
e County
. City

At this time, the i-Tree Planting Calculator is only for users located within the United States. Please contact support@itreetools.org for more information
about funding needed for your area.

Arbor Day Foundation” i’m;o

DAVEY‘%O




A collaborative initiative with % i-[ree Planting 0 Home  Projectv  Menuv  i-Tree Feedback ~

i-Iree

Location Parameters Trees Report

RNIA DEPARTM,
‘,ufs‘}“ FIRE: Pno,:go;
oy

¢05

Project Parameters

Configure the local parameters for the project.

Electricity Emissions Factor
505.21

This field is required.
Units
pounds GQ» equivalent/MWh ® kilograms GO» equivalent/MWh

vvvvvvvv At ottt S

Fuel Emissions Factor
68.71

This field is required.
Units

Years for the Project (1 thru 99)

40

Tree Mortality over Project Lifetime, as an estimated percentage (Optional, 0 thru 100)

10




A CO||ab0ratlve |n|tiative W|th % i—Tree Planting e Home Project v Menu v i-Tree Feedback ¥

i-Iree

Location Parameters Trees Report

FORNIA DEPARTY o
AUFORY & FIREPROTENT o)
:aﬁis‘“ T“hgf'

Tree Planting Configurations
Enter the tree groups for the project.
Units

@® English (feet & inches)  © Metric (meters & cm)

Nomenclature

® Common Name © Scientific Name

Tree Group Information Building Information Tree Details

Distance
to
DBH in  Nearest Tree is of Climate Exposure to Nu|
Species inches in feet Building Vintage Controls Condition Sunlight

v Apple i(0-19 7)i( North (0°) %)i( Built after 1980 %)
Apple, Paradise i H H i
Ash
Ash, American mountain
Ash, Black
Ash, Carolina
Ash, European mountain
Ash, Green
Ash, Summit
Ash, White
Aspen, Bigtooth
Aspen, Quaking
Baldcypress
Basswood
Basswood, American
Bayberry, Southern
Beech

(Heat& A/C ) i ( Excellent ¥ i (FulSun %)

Use of this tool indicates acceptance of the EULA.




A collaborative initiative with ??u i-Tree Planting ,,,;  Home Projects  Menu~  i-Tree Feedback v
1-iree.

Location Parameters Trees Report

DEPARTy

,anml Ms,"
AUECRY & FIRE PROT-NT
:a;{ESTl rs(%;

Planting Report 8 Print

NOTE: Printing is recommended as the "landscape" orientation or at a reduced scale.

Project Report - i-Tree Planting Calculator.,,;

Location: Springfield, Massachusetts 01109 n
Electricity Emissions Factor: 505.21 kilograms CO2 equivalent/MWh I-TI‘ ccC.
Fuel Emissions Factor: 68.71 kilograms CO2 equivalent/MMBtu Planting
Lifetime: 40 years

Tree Mortality: 10%

All amounts in the tables are for the full lifetime of the project.

Units
@® English (pounds & tons; kWh & MMBtu; gallons)  © Metric (kilograms & metric tons; KWh & MMBtu; cubic meters)

Copy Export CO,  Energy Eco Air Pollution Search:
Location CO, Benefits
It co, co, co, o,
Group Avoided Avoided Sequestered Sequestered
Identifier Tree Group Characteristics (pounds) $) (pounds) $)
1 e (1.0) Apple (Malus species) at 1.0 inch DBH. 2,649.2 $61.61 2,192.2 $50.98
o Planted 0-19 feet and north (0°) of buildings that were built post-1980 with heat
and A/C.

o Trees are in excellent condition and planted in full sun.




Powerpoint and Resources
www.unri.org/lexington/

www.itreetools.org

www.unri.org

David Bloniarz

USDA Forest Service
Bloniarz@umass.edu
txt 413-537-3748
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